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Introduction

Thank you for choosing Amadeus II. This shareware is a powerful tool that allows easily to record, play,
analyze and manipulate sounds. It provides several professional features like direct-to-disk sound manipula-
tion and 24Bit sound handling. It also allows to export files using various compression algorithms, including
Mp3, QDesign Music 2 and the new Ogg Vorbis format.

This reference guide describes briefly the main functions of Amadeus II. It is by no means supposed to
be exhaustive. The functionalities described here apply to Amadeus II v3.5. Some functions may not be
present on older versions.

HairerSoft is the name under which I, Martin Hairer, develop software since march 2002. I am a researcher
in mathematical physics who likes programming. This program was developed entirely during my spare
time and is not my main occupation in life. Because of this reason, no exhaustive testing could have been
performed. Since some functionalities are system-dependent and/or machine-dependent, it may happen that
Amadeus II presents some dysfunctionalities on your personal configuration. If so, please feel free to
contact me at martin@hairersoft.com. For obvious reasons, I always assume you are in possession of the
latest available version of Amadeus II. You can check the number of the latest version (and of course also
download it) at

http://www.hairersoft.com/Amadeus.html .

Just to avoid getting in any trouble, I have to mention that I am not responsable for any damage that may be
caused by this or any other version of Amadeus II to your machine.

Installation notice

This release is made of one folder which you can place anywhere on your hard disk. It is important not to
remove the application file from this folder. Otherwise, Amadeus II will not find its plugins, which means
that many functionalities will not be available.

On MacOS X, you are encouraged to place the content of the “VST plugins” folder into your

˜/Library/Audio/Plug-Ins/VST/

folder.

System requirements

This version of Amadeus II runs on MacOS 8.6, MacOS 9.x, and MacOS X. MacOS 8.1 is no longer
supported. On versions of MacOS before MacOS X, Amadeus II requires CarbonLib v1.3 or later to be
installed. You can download the latest version of CarbonLib at

http://www.versiontracker.com/.

Amadeus II requires at least 20MB of free RAM. It furthermore requires a sufficient amount of free space
on your hard disk (typically a few times the size of the currently open sound file).

1 What’s new?

Here is a list of the major new features of version 3.5, compared to version 3.2.
� Better overall performance on MacOS X (using CarbonEvents).
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� More consistent user interface with better integration to Aqua.
� Uses AltiVec instructions (G4 processors only).
� Real-time VST effects.
� Improved management of large files under large memory conditions.
� Recording gain control on MacOS X.
� Stereo recording gain control.
� Timer for recording.
� Support of ID3v2 tags in Mp3 files.
� Better control of the playback settings.
� New user interface for sound repairing (with preview).
� New user interface for sound playback.
� Complex waveform generator.
� New key shortcuts.

2 The documents

There are three types of documents handled by Amadeus II.

2.1 The sound windows

They are the main “working place”. The sound is depicted as a wave showing the pressure as a function of
time. If you create a new window, it is gray, meaning that no sound is present. In order to select a part of
the sound, just click at the beginning of the select and drag the mouse until the end of the selection. The
“shift” key allows you to extend the current selection. If the sound has several channels, all of them will be
selected. In order to select only one channel, hold down the “option” (“alt” on some keyboards) key.

There are two small white strips above and below the one(s) containing the sound itself. The lower strip
shows a time scale. The upper one contains the marks of the current sound (if some are present). To create
a mark, just click into that strip and drag the mouse to the appropriate location.

On the top of the window, the Show Whole Sound function provides an alternative way to navigate in a
huge document. This function is only enabled if the sound is large enough. The visible part of the sound
is depicted by a white rectangle surrounded by a blue frame. You can change it by either dragging it or
extending the sides of the frame.

There are four small icons at the left bottom of the window. The first one allows to change the time scale at
which the sound is to be drawn. If you click onto the second one, a dialog showing the characteristics of the
sound opens. If the sound is currently stored on a hard disk, you can try to load it into RAM. The third icon
allows to set the volume level at which the sound is to be played. The last icon allows to set if the sound
has to be looped at playback or not. If the sound is stored on a hard disk, it may not be a good idea to loop
a short sequence, since this causes the reading device to jump very quickly forth and back. If the hard disk
does not “keep up” with the sound playback, your machine may crash.

The small icon at the top right of the window allows to change the amplitude scale of the displayed sound.

2.2 The “Sonogram” windows

A “sonogram” is a graphic representation of a sound showing the frequency as a function of time. The
amplitudes of the different frequencies are shown as colors. For example, a pure sound will be represented
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by a straight horizontal line, because there is only one frequency present. Sonograms are a quite useful tool
to compare sounds or to find out which notes are present in a chord for example.

A sonogram window is composed of three parts: A tool bar, the sonogram itself and the sound from which
it was produced.

The toolbar. On the left side is a pop-up menu that allows to change the color palette and a slider that allows
to change the color scale of the sonogram. The color scale determines which color has to be attributed to
which amplitude. If you glide the slider to the right, the color scale becomes more sensitive, i.e. small
amplitudes will become visible.

On the right side are two icons. The first one opens a dialog that allows to set the different color palettes.
The second one opens a dialog that allows to change the different parameters of the sonogram. Here is
a short description of them. Max. Frequ. is the maximal frequency shown in the sonogram. If you
lower it, you will have a better vertical resolution but you will cut off the high frequencies. Sizes FFT
is the number of points considered in one Fourier transform. If you increase this value, you increase the
quality of the sonogram, but the computation gets slower. Sizes Picture is the vertical size of the sonogram.
Frequ. Scale allows to choose between a linear and a logarithmic frequency scale. Ampl. Scale allows
to choose between a linear and a logarithmic amplitude scale. In the case of a logarithmic amplitude scale,
Gain allows to choose the difference in dB of the amplitudes corresponding to the first and the last color
in the color scale. Emph allows to preemphasis the spectra in order to magnify high frequencies, which
have usually lower amplitudes. It is also possible to choose a windowing function in this dialog box (see
Section 4.6.1 for more details about windowing functions) and to change the resolution of the sonogram.
Changing the resolution has no effect on the picture drawn on the screen, but it causes the sonogram to be
recomputed in a higher quality when it is exported.

The sonogram. If you click into this part, a small window appears, showing the frequency corresponding
to the location of the mouse, as well as the note that is closest to that frequency.

You can copy the sonogram into the system scrap by choosing Copy Picture in the Edit menu.

The sound. This part of the Sonogram window behaves exactly like the Sound window, but you cannot
select anything. The three small icons in particular have the same behavior.

2.3 The “Spectrum” windows

A “spectrum” is a graphic representation of the amplitude as a function of the frequency at one point of a
sound. A spectrum is in fact a “vertical cut” of a sonogram.

The Spectrum window contains two pop-up menus allowing you to change the color used to display the
spectrum, as well as the type of scale (linear or logarithmic) used for the amplitudes.

The Detect peaks function is very useful to gain more precise information over the frequencies composing
a sound. When it is enabled, Amadeus II tries to evaluate the precise frequency corresponding to a peak by
using the phaseshift and the amplitude ratio between that frequency band and the neighbouring frequency
bands.

3 The floating palettes

There are four floating palettes which can be shown/hidden using the Windows menu. Here is a short
description of their contents.

The navigator palette. This palette allows to control the playback of the sound contained in the currently
frontmost window. The three first icons correspond to the Play, Stop and Record... menu items respectively.
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When a sound is playing, the Play button becomes a Pause button. The fourth icon is split into two parts
and allows you to rewind the sound or to play it faster.

The two text fields located at the right of this palette display the playback position and the remaining time
of playback.

The memory palette. The progress bar shows the fraction of the heap used by Amadeus II. Total memory
is the total amount of the heap allocated to Amadeus II by the system. This amount can be changed by
selecting the application program in the Finder and selecting the Get info... item in the File menu. Free
memory is the part of the heap that is not used by Amadeus II.

This palette is not available under MacOS X, since memory allocation is dynamic there.

The selection palette. It contains the coordinates of the selection of the sound contained in the frontmost
window. The first time is the length of the selection, the second one is the start of the selection and the last
one the end of the selection. The units can be changed in the Preferences... dialog of the Edit menu.

If you click into this palette, it has the same effect as selecting the Set Selection... item of the Selection
menu.

The playback palette. This palette allows to select which part of the sound should be played back. The
default behaviour is to play either the selection (if it is longer than about 0.03 seconds), or the whole sound.
You can change this behaviour in order to play for example from the last marker preceding the selection until
the first marker following the selection (check the “Set playback range” box and select “Previous Mark” and
“Next Mark” in the two pop-up menus). You can also ask the program to skip a part of the sound that is
played back (for example the selection). This is useful to preview the effect of cutting out the selection for
example. In order to get the same playback behaviour as programs like SoundStudio or Peak, check the “Set
playback range” checkbox and select “Start of Selection” and “End of Selection”.

The “Display follows playback” function allows to tell the program to follow the sound when it is being
played back.

4 Menu commands

4.1 The “File” menu.

“New”. Creates a new sound file. The characteristics of this file can be set in the Preferences... dialog of
the Edit menu.

“Open...”. Allows to open a file (sound or sonogram) previously saved on disk. Fully recognized sound for-
mats are Audio IFF (compressed and uncompressed), System Sound, WAVE (uncompressed only), Sound-
Designer II, Mp3, and Ogg Vorbis. If the document format is different from the formats above, Amadeus
IIwill try to open the file using QuickTime. The recognised file formats may differ depending on your
version of QuickTime.

If there is not enough memory left to load the sound, Amadeus II opens it anyway and handles it direct-to-
disk. This is very useful to open huge sounds (up to 2GB).

“Close”. Closes the frontmost window. If it contains an unsaved document, the user is asked if he wants to
save it.

“Save”. Saves the content of the frontmost window on the hard disk. If there is no file associated to that
window yet, the behavior of Save is the same than that of Save as....
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“Save as...”. Shows the standard saving dialog. If the document to be saved is a sound, you can choose
between several file formats. Formats recognised so far are Audio IFF, WAVE, Mp3, Ogg Vorbis, � -Law,
System Sound, Movie and AVI sequence. For every format (except WAVE), the “Settings...” button allows
to choose several parameters, for example a compression algorithm.

If QuickTime is not fully installed, some file formats are unavailable. If you compress a sound, be conscious
that some quality may be lost, particularly if the compression rate is high, so test the results of the different
compression laws before you use them.

The LAME encoding engine is a free Mp3 encoding engine originally developed by Mike Cheng

http://members.dingoblue.net.au/˜mikecheng/ �

It is licensed under the LGPL (GNU Library General Public License). For a copy of the LGPL, see the file
COPYING also located in the Lame folder. The Lame source code can be obtained at

http://www.mp3dev.org/mp3/ �

Ogg Vorbis is a general purpose compressed audio format for high quality (44.1-48.0kHz, 16 bit, poly-
phonic) audio and music at moderate fixed and variable bitrates. This places Vorbis in the same class as
audio representations including Mp3. Vorbis is the first of a planned family of Ogg multimedia coding for-
mats being developed as part of Xiphophorus’s Ogg multimedia project. See http://www.xiph.org/ for more
information.

If the frontmost window is a sonogram, “Save As...” allows to save it either in a file format owned by
Amadeus II (such files can then be opened again), or in one of the many different graphics formats provided
by QuickTime.

“Import Raw Data...”. This allows you to import raw sound samples. This may be useful if the sound you
want to open is not recognised by Amadeus II or if you want to “cheat” on the sampling rate of a sound.

“Export Raw Data...”. This item allows you to save the raw sound data of the current sound window into
a file. The resulting file does not contain any information about sampling rates, sound quality, markers, and
so on. This function is only intended for low-level communication between applications.

If the “Generate Windows-style data” option is checked, the sound data is saved in little Endian format, as
opposed to the big Endian format used on Macintosh platforms.

“Print...”. This allows you to print sonograms, spectrums, and so on. Only the sounds themselves can not
be printed for obvious reasons.

“Page setup...”. Allows to change the setup for the printer.

“Quit”. Terminates the program after closing all documents.

4.2 The “Edit” menu.

“Undo”. Undoes the last action performed in the frontmost window. For Sound windows, multiple undo-
ing is supported up to a level that can be set in the Preferences... dialog.

“Redo”. Annihilates the effect of Undo.

“Cut”. Equivalent to Copy followed by Clear.
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“Copy”. Copies the selection of the frontmost window into the scrap. If the window is a Sound window,
the selection is copied into the current internal scrap. The current scrap can be chosen in the Scrap submenu.
If you switch to another application, the current scrap is placed into the system clipboard, provided that you
checked the “export scrap” box in the Preferences... dialog and that there is enough RAM left. If you do not
intend to communicate data between other applications this way, it is recommended not to use the “export
scrap” option.

“Paste”. If no sound is selected, it inserts the content of the current scrap at the insertion point of the
frontmost Sound window. If a sound is selected, the selection is deleted first. If the quality of the scrap
doesn’t fit the quality of the frontmost Sound window, the content of the scrap is first converted as to fit
that quality. Notice that the content of the scrap is not affected by this operation. If you switch from another
application to Amadeus II and the system clipboard contains some sound data, it is placed into the current
scrap.

“Clear”. Deletes the current selection.

“Crop”. Deletes everything but the current selection.

“Select all”. If the frontmost window is a Sound window, extends the selection of the sound to the whole
sound.

“Copy Picture”. When a sonogram is open, this copies its content into the system scrap.

“Paste Over”. Mixes the content of the current scrap to the sound contained in the frontmost Sound win-
dow. It will start exactly at the beginning of the selection, not depending of the size of the selection. If the
qualities don’t fit, the content of the scrap is automatically converted.

“Copy to New File”. Opens a new file with the content of the current selection. It doesn’t copy the selection
to the scrap, so the content of the current scrap does not get lost.

“Copy to New File”. Opens a new file with the content of the current selection. It doesn’t copy the selection
to the scrap, so the content of the current scrap does not get lost.

“Scrap”. Allows to change the current scrap. The default behaviour of Amadeus is to always use a different
scrap (in a circular way) when you use the “Copy” and “Cut” function.

“Preferences...”. Opens a dialog that allows to change the behavior of Amadeus II. In particular, you can
set the default quality of a new sound and the units at which a time has to be displayed. When the Don’t
use QuickTime option is set, Amadeus II doesn’t make any calls to QuickTime function. There is an
incompatibility between Amadeus II and some installations of QuickTime 5 which may on some operating
systems cause crashes in the Save... function. If this happens on your installation, you should turn the Don’t
use QuickTime option on.

It is also possible to change the default location of temporary files. In principle, it is strongly recommended
to leave the Don’t use Network Volumes and Don’t use Removeable Volumes flags turned on.

4.3 The “Selection” menu.

This menu contains numerous functions that allow to gain full control over the extent of the selection, as
well as some functions to handle marks.

“Set Selection...”. Opens a dialog box that allows to set the selection precisely. The numerical values have
to be entered in milliseconds. If marks are present, the Mark... buttons allow to put the position of a mark
into the corresponding text field.
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“Mark Selection...”. Allows to put one mark at the beginning of the current selection and one at the end.
If no sound is selected, it puts a mark at the current insertion point.

“Jump to”. The pop-up menu attached to this item allows you to choose the selection, the whole sound,
a mark or the time between two marks. The program then changes the time scale and the position of the
scrollbar of the frontmost Sound window in a way that the chosen part of the sound fills exactly the width
of the window.

“Extend to Start”. Extends the selection to the beginning of the sound.

“Extend to End”. Extends the selection to the end of the sound.

“Extend to Next Marker”. Extends the selection to the location of the first mark that comes after the end
of the selection. If there is none, it has the same effect as Extend to End. This function can also be accessed
by pressing command-right arrow.

“Extend to Previous Marker”. Extends the selection to the location of the last mark that comes before the
beginning of the selection. If there is none, it has the same effect as Extend to Start. This function can also
be accessed by pressing command-left arrow.

“Crossings”. This allows to extend the selection to the nearest points where the waveform crosses the
origin. The Settings... function allows to choose which type of crossings (upwards, downwards or both) are
recognised as such.

“Save Selection As...”. Behaves like Save As..., except that it creates a sound that contains only the current
selection.

“Split According to Marks...”. Splits the sound into pieces according to the marks. The “Start color”
indicates the color of the marks that specify the beginning of a piece, the “End color” indicates the color
of the marks that specify the end of a piece. If you choose the “Consider all marks” option, the function
behaves as if all the marks had the same color.

The name of each piece of sound is equal to the name of the mark located at its beginning. Once you have
selected “OK”, a standard file saving dialog appears, in which you have to enter the name and location of
the folder that will contain the various pieces.

“Join Files...”. This is the complementary function to the Split According to Marks... function. It allows
to concatenate several AIFF files into one big file. The dialog box allows to choose the quality of the
resulting file. If the chosen files are compressed, Amadeus II automatically decompresseses them before
concatenating.

“Clear All Marks”. Deletes all the marks of the frontmost sound.

“Clear Marks in Selection”. Deletes all the marks in the current selection of the frontmost sound.

“Generate Marks...”. Allows to generate equidistant marks on your sound. This is especially useful in
conjunction with the Split According to Marks... function if you want to cut a very long sound into pieces
of reasonable size.

If the sequence of characters %N is found inside the “Text” text field, it is replaced for each generated
marker by its number (1 for the first marker, 2 for the second, and so on).

4.4 The “Sound” menu.

This menu regroups mainly the items involved in the acquisition and the reproduction of sound.
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“Play”. Plays the sound contained in the frontmost Sound Window. If the selection is longer than a few
milliseconds, only the selection is played, otherwise the whole sound is played. If “Set playback range” is
selected in the “Playback” palette, the corresponding region is played. This menu item can be accessed by
pressing the space bar.

“Play From Insertion.”. Similar effect than Play, but the sound is played starting from the beginning of the
selection until the end of the sound is reached. This menu item can be accessed by pressing the tabulation
key.

“Play Between Marks...”. opens a dialog box in which you can choose two marks of the current sound.
The sound between the two selected marks will then be played.

“Record...”. Opens a window that allows to record a sound from any input device recognized by the Sound-
Manager. The first progress bar indicates the length of the recorded sound (If it is filled, the maximal length
has been reached). The maximal length of the recorded sound can be set in the Preferences... dialog box.
If you shorten it, you use less disk space when this window is open. The second progress bar indicates the
volume level measured by the active input device. The “Peak” indicator turns red if a too high level has been
reached at least once during the recording.

It may happen that your sound input device is not able to sample sound at the quality you request. In that
case, Amadeus II will do the resampling automatically in real-time while recording.

“Record to New File...”. This command behaves exactly like the Record... command, except that it cre-
ates a new sound document containing the recorded sequence. The quality of this document is the default
quality that can be set in the preferences. If you intend to record a sound of a certain length, it is highly
recommended to use this function rather than the Record... function, since the sound will not be duplicated
when you hit “OK” and so everything is much faster.

The Max. CPU checkbox allows to freeze all the other applications while recording. This is useful to
minimize the risk of having cuts in the recorded sound, especially if your hard drive is not very fast. This
option is only available on cooperative mutitasking operating systems. The Mark Sound checkbox allows
to generate marks containing the system time at the beginning and at the end of the recording.

The “Dump to file...” function allows you to save the recorded sound while it is being recorded. If your
machine is sufficiently fast, you can create Mp3 files in real-time this way.

“Jump to Play Position.”. When a sound is currently being played, this function selects 250 milliseconds of
sound about 0.2 seconds before the actual playback position and then calls the Zoom to selection function.
This can be quite useful to detect the position of a crack in a sound for example.

“Stop”. Stops playing the frontmost sound. If the Recording window is open, stops the recording.

“Pause”. Pauses the playback. If the Recording window is open, pauses the recording.

“Resume”. Resumes the playback. If the Recording window is open, resumes the recording.

“Characteristics...”. Opens a dialog allowing to change the characteristics of the frontmost sound. This
operation can also be undone.

Be aware of the fact that 24Bit sound can not be recorded by the actual versions of the SoundManager, so
this is mainly useful to preserve high quality even if you apply many effects.

If you work on large sounds in the direct-to-disk mode, it may happen that Amadeus II fragments the sound
in order to gain speed. If a sound is too fragmented, it may happen that the contrary effect is achieved, so
you can defragment a sound. Defragmentation of a sound is automatically performed when you save it.
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“Playback Pitch...”. Allows to play the sound at a rate different to the recording rate. This function may
not produce satisfactory results if the playback rate is too high, due to hardware limitations.

4.5 The “Effects” menu.

The first menu article in the “Effects” menu allows to apply once more the latest effect.

“Echo...”. Allows to apply an echo to the current selection. If you check the Go further box and put a
value of � seconds in the text field, the echo of the selection will be prolongated by � seconds. Nevertheless,
no echo will be applied to the � seconds following the selection.

“Amplify...”. Allows to amplify the selection by a given factor. If the “fading time” is non-zero, a smooth
transition is made between the amplified and the non-amplified sound.

“Filter...”. Allows to apply a frequency filter to the current selection. This item is similar to the graphic
equalizer of a hifi chain.

The remainder of the Effects can be filled by the sound processing plugins detected by Amadeus II. For
the moment being, the standard release of Amadeus II contains ten sound processing plugins, which are
shortly described below.

“Denoising”. This plugin provides a very efficient algorithm for suppressing background noise. The easiest
way to use this algorithm is the following:

� Select a piece of your sound containing only noise.
� Select the menu item Sample noise. The plugin will scan the selected noise and construct a noise

profile.
� Select the whole piece of sound.
� Select the menu item Suppress noise. This will remove the background noise from the selected part of

the sound, according to the noise profile constructed previously.

Sometimes, there is no piece of sound containing only noise available. In this case, one should use the Sup-
press White Noise function. This function nevertheless requires an estimate of the noise level. Advanced
users can extract this noise level from the Waveform Statistics or from a spectral analysis. Another way to
proceed is to start with a very low value of the RMS Power (for example -70dB) and to make several trials,
every time raising the RMS Power, until one reaches the point where all the noise is removed. Choosing a
too large value of the RMS Power will result in a significant loss of quality in the clean signal.

It may happen sometimes that the background noise one wishes to remove is very well localised in frequency.
In this case, it is possible to use the Suppress Frequency Band... function to remove every frequency
localised between the Lower Frequency and the Upper Frequency.

Finally, the Remove Low Frequencies function allows to remove a low-frequency drift in the microphone
(this happens for example on the integrated microphone of some powerbook models).

The Denoising function is customizeable with the Options... function. The “Noise Type” allows you to
choose the type of noise you want to remove. Choosing a peaked noise is suited for background noise which
is very well localised in frequency space. A typical example is the removal of the 50Hz humming produced
by the power supply. The “smooth noise” function is adapted to the removal of noise that is spread over
the whole frequency range, like for example a tape hiss. If the “Adaptive Filtering” option is disabled, the
program will compute one global filter and apply this filter to the whole sound. This sometimes yields better
results when the signal-to-noise ratio is very low. The “Sensitivity Enhancement” option tells the program
the amount of background noise to remove. Usually, values between 30% and 70% yield the best results.
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For lower values, some background noise may remain after the application of the filter. For higher values,
the signal may be substantially altered.

The “Algorithm” pop-up menu allows to choose which algorithm should be used for the denoising. Cur-
rently, two algorithms are available: “Short FFT” and “Long FFT”. Generally, the “Long FFT” algorithm
produces better results, but the “Short FFT” algorithm is faster.

“Fadings”. This effect allows to make fade-ins or fade-outs of various types. To change the type of the
fading, open the Settings... dialog and select one of the four different types. The Cross-Fade function
allows you to make a fading between two given amplitudes (and not only between 0 and 100%).

The Transition to the Left and Transition to the Right functions allow you to easily create a transition
between two pieces of sound. This is how it works. Let’s say you want to produce a file containing the songs
“Song A” and “Song B”. Copy them one behind the other into your file and place a marker at the junction
of both songs. Then select, say 1 second of “Song B” starting from the marker and select Transition to
the Left. This will first create a Fade In of 1 second at the beginning of “Song B” and a Fade Out of 1
second at the end of “Song A”. Then it will merge these two parts into one, creating a nice transition. The
Transition to the Right produces the same result if you select 1 second at the end of “Song A”.

“Normalize...”. This allows to normalize the amplitude of the selected sound with respect to the maximal
possible amplitude. You can choose either to treat both channels independently, or to apply to them the same
amplification factor.

“Repair”. This effect allows to suppress a crack in a sound. In order to achieve this, first search for the
crack. This can be done for example with the help of the Jump to play position function. Then select the
crack and a very short piece of sound before and after it. Make the selection as short as possible (about
40-50 ms maximum)! Then you can select the “Interpolate” menu item. Try different settings and preview
them to get optimal results.

You can use the “Repair center” to have access to all the available functions in a single click. The “Repair
center” also allows to search and repair cracks automatically.

“Reverse”. This effect simply makes a time-reversal of the selected sound.

“Sample Filters”. This effect allows you to damp either high or low frequencies of your sound.

“Set Pitch...”. This effect allows to physically change the pitch of a portion of the sound.

“VST plugins”. The most recent versions of Amadeus II include support for VST plugins. In order to
install other VST plugins than the ones distributed with Amadeus II, simply move them anywhere in the
folder containing the application file Amadeus II, or into one of its subfolders. On MacOS X, you should
place your VST plugins into the ˜/Library/Audio/Plug-Ins/VST folder.

The “VST Audio Rack...” function allows to apply several VST plugins in a row.

“Simple generators”. This effect allows to generate simple sounds like sine waves, or white noise. White
noise is particularly useful if you want to test the effect of a filter. (Apply it to 5 seconds of white noise
and then compute the average spectrum of the noise. This will reproduce exactly the response of your filter,
since pure white noise has a flat spectrum on average.)

The “Complex Waveform...” function allows to generate a sound by specifying the respective amplitudes
of its fundamental frequency and its successive harmonics. If “Waveform modulation” is checked, Two sets
of harmonics can be specified and the sound alternates periodically between both of them. If “Amplitude
decay” is checked, the harmonics are damped exponentially, with a decay rate that is proportional to their
frequency.
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“Generate silence...”. This function allows to generate a silence of a specified duration.

“Stereo Utilities”. This plugin provides a few functions useful for handling stereo sounds. The function
Invert Phase inverts the phase of the selected piece of sound (meaning that it simply applies to the samples
the map ������� ).

4.5.1 About the plugin development kit

The Amadeus development SDK is currently in a development stage and is therefore not officially available.
Many functionalities are currently being added to it and details are still changing, although the overall plugin
architecture is now fixed. If you wish to use the current version of the development SDK, please contact me
directly.

4.6 The “Analyze” menu.

“Spectrum”. Makes a spectral analysis of the selected sound and stores the result in a Spectrum window.
It is possible to apply a windowing function to the spectrum. It is also possible to compute the average
spectrum of the whole selection. The “Overlap” field contains the length (in points) of the ovelap between
two successive FFTs. Notice that the “Number of points” contains the number of points in the spectrum
analysis. The actual number of sound samples needed to compute this spectrum is in fact two times bigger.

“Animated Spectrum...”.

This opens a window that is very similar to the “Real-time spectrum”. The only difference is that the sound
data is not fetched from the current sound input, but from the currently active sound window. In order to see
the animated spectrum, you have to play that sound back. The easiest way to do so is to simply hit the space
bar.

“3D Spectrum...”.

Makes a 3D spectrum out of the selected portion of sound. You have to select at least 10’000 samples (which
corresponds approximately to 0.5 seconds of a sound sampled at 22’050 kHz). The modal box that shows
up when you select this function allows you to select the total number of spectra and the maximal frequency
that shows up.

An 3D spectrum is a three-dimensional representation of a sound which consists of several spectral analyses.
One can change the color palette used to colorize the spectra. The available color palettes are the same as
for the sonograms.

If you click into the window, a small window shows up containing the frequency corresponding to the
location of the mouse. If you want to get the frequency of a particular peak, you have to click at the bottom
of the peak to get the right value.

If you choose Copy in the Edit menu while a 3D spectrum is the frontmost window, the program copies the
picture into the scrap.

“Sonogram...”. Creates a sonogram from the current selection.

“Waveform Statistics...”. Opens a window containing statistics on the current selection. If the sound is
stereophonic, the left column corresponds to the left channel and the right column to the right channel. The
meaning of the various numbers is the following.

� The “Minimum/Maximum Sample Value” is the minimal/maximal value the sample take in the current
selection. These values are normalized in such a way that the clipping values are ��� .
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� The “Peak Amplitude” is the amplitude of the difference between the maximum and the minimum
sample value. This amplitude is given in dB with respect to its maximal value (which is 2).

� “Possibly Clipped Samples” indicate the number of samples that take the extremal values ��� .
� “DC Offset” indicates the average vertical offset of the waveform. It is given in % of the maximal

possible value.
� “Minimum/Maximum/Average RMS Power” gives the minimum/maximum/average value of the root

mean square power in the selection. These values are given in dB with respect to their maximal val-
ues (which are atteined for a square wave with maximal amplitude). The size of the window used to
compute the RMS power can be adjusted.

“Real-time spectrum...”. Opens a window which shows a real-time spectral analysis of the sound entering
into the current sound input device. There are many options to affect the display of the spectrum. The
“preemphasis” option allows to amplify artificially the high frequencies.

This function seems to me a great pedagogical tool to show how a note is composed of a fundamental
frequency and its harmonics for example.

“Oscilloscope...”. Opens a window that shows in real-time the sound entering into the current sound input
device.

“Multiband RTA...”. Opens a window with a real-time spectrum analyzer on a “log-log” scale. It behaves
sessentially like the spectrum analyzer on a hifi chain, except that amplitudes are shown in decibels relative
to the mean amplitude of the sound. The consequence is that the frequency profile of a given sound will not
depend on its overall amplitude.

“Waterfall...”. Opens a window with a real-time waterfall display. The meaning of the picture is exactly
the same as the meaning of a sonogram, except that the time-axis is the vertical one an the frequency axis is
the horizontal one. The “Settings...” button allows to change the speed of the display. It also allows to dump
the result of the spectrum analysis into a file. This file will simply be a text file, so that it can be imported
easily into Excel or some other data analysis program like Matlab.

4.6.1 Windowing functions

Windowing functions are available for all spectrum analysis functions. Applying a window to a wavefrom
before computing its spectrum is especially useful for sonograms. There it allows to get much sharper and
more regular pictures. The “Kaiser” windowing function allows you to specify the “broadness” (or variance)
of the windowing function. The smaller the number, the closer the result will be to what you get without
windowing. As a general rule, if you increase the number of points you use for the FFT, yo should decrease
this value for optimal results.

For a more detailed overview on windowing functions, you can visit the page

http://www.mathworks.com/access/helpdesk/help/toolbox/signal/hamming.shtml �

and the other pages on the same site.

If you want to make quantitative use of the content of a spectrum, you should in most cases not use any
windowing to produce it.

4.7 The “Windows” menu.

This menu contains the list of currently open windows and floating palettes. The windows are grouped
according to their type. This menu is disabled when a modeless dialog box is currently active.
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5 Some Tricks

Here is a collection of some tricks which I found useful when using Amadeus II.

� If you want to record a long piece of sound (say more than one or two minutes), use the “Record to
New File...” function. The “Record...” function will make a copy of your sound when you click on
“OK”, which may take a considerable amount of time.

� On MacOS 8.x and MacOS 9.x, give Amadeus II as much memory as possible for optimal perfor-
mance. You can set the memory allocated to the program by selecting it in the Finder and choosing
“Get Informations” or typing command-i.

� In order to manipulate a very long sound, first cut it into pieces of convenient size using the “Generate
Marks...” and then the “Split According to Marks...” functions. Work on those pieces separately, then
glue them together using the “Join Files...” function.

� When you save files in an intermediate stage of your work (which is highly recommended), always
save them as uncompressed AIFF files. This way, you will not loose any quality and the saving and
opening will be much faster than with other file formats.

� Use option-click to select individual channels and command-click to place a marker at the location of
the mouse.

� Take a look at the “Useful Shortcuts” section below, it can save considerable amounts of time...
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6 Useful shortcuts

Here is the list of “hidden” shortcuts that can be used with Amadeus II:

key action

space bar Starts sound playback
space bar When recording, starts/stops the recording
tabulation Starts playing from the insertion point
tabulation When recording, places a marker at the current point

shift-tabulation When recording, places a nameless marker at the current point
period Pauses the playback

left arrow Shifts the content of the window to the left
right arrow Shifts the content of the window to the right

left arrow When playing, jumps back by 0.5 seconds
right arrow When playing, jumps forward by 0.5 seconds

down arrow Slows down the playback by half an octave
up arrow Speeds up the playback by half an octave

command-down arrow Plays back at half speed
command-up arrow Plays back at double speed

command-left arrow Extends the selection to the previous marker
command-right arrow Extends the selection to the next marker

command-left arrow When playing, jumps to the previous marker
command-right arrow When playing, jumps to the next marker

option-left arrow Places the insertion point at the left end of the selection
option-right arrow Places the insertion point at the right end of the selection

page up Jumps to the beginning of the sound
page down Jumps to the end of the sound

control-d Inserts the system date (in text fields)
control-t Inserts the system time (in text fields)

a Extends the selection by one point to the left
s Shrinks the selection by one point at the left
d Shrinks the selection by one point at the right
f Extends the selection by one point to the right
j Jumps to the current playback position

m Marks the playback position if the sound is playing
and the current selection otherwise

+ Zooms deeper into the sound
- Zooms out of the sound

option-click Allows to select only one channel
command-click Places a mark at the clicked point

shift-click Extends the selection to the clicked point
double-click Starts playing from the clicked point

There are also a few hidden shortcuts that can be used in the “Repair center”:
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key action

r Repairs the current selection
n Searches for the next crack
p Plays the repaired sound
o Plays the original sound

7 Troubleshooting and FAQ

Q: When I try to launch Amadeus II, a message saying “Could not launch Amadeus II because
CarbonLib was not found” appears.

A: Amadeus II is a “carbonized” application, meaning that it runs as well on MacOS X as on older
versions of MacOS. On MacOS 8.x and MacOS 9.x, it therefore needs a library called “CarbonLib” to
run. You can download this library on www.versiontracker.com for example.

Q: When I try to open a QuickTime movie, Amadeus II shows the error message “QuickTime com-
ponent not found”.

A: Your QuickTime installation is probably not complete. Make sure that the extension “QTCapture” is in
your extensions folder.

Q: The “Suppress White Noise...” function distorts my sound very badly.

A: Choose a lower value of the “RMS Power”. Typical values for removing a tape hiss are between -50
and -70dB.

Q: My VST plugins are not loaded under MacOS X.

A: Some VST plugins are not yet carbonized. They can therefore not be used under MaxOS X.

Q: Where have the “Use Max. CPU” checkboxes gone?

A: MacOS X uses preemptive mutitasking, whereas older versions of MacOS used cooperative multitask-
ing. This means that under older versions of MacOS, an application could take over the whole processor
time for itself, therefore stopping the execution of all other processes (the Finder, for example). This is
what the “Use Max. CPU” function did. Under MacOS X, this is no longer possible since the processor
time is completely managed by the operating system.

Q: I am unable to record any sound.

A: Make sure that the correct sound input device is selected. If it is the case, make sure that your fastest
hard drive is selected in the “Temp. File” section of the preferences. Change your sound quality in such
a way that the “requested quality” and the “obtained quality” are the same, in order to minimise the
CPU load. If this still doesn’t help, try to see if there is an extension or a background process making
frequent disk accesses or other driver accesses and remove it.

Q: When I try to save an Mp3 file, I get an error message saying that the LAME encoder returned
an error.

A: The LAME encoding engine used by Amadeus II to produce Mp3 files does not accept to produce any
kind of Mp3 file from any kind of audio data. It does for example not accept to produce a low-quality
Mp3 (lower than 80kbps) from an audio file sampled at a high frequency. If this is the case, try to
resample your file at 11.03kHz. (You can set this in the “Settings” dialog.) On the other hand, LAME
also doesn’t accept to produce high-quality Mp3 files from low-quality audio data, but you can force
this by resampling at a high rate, although this doesn’t really make sense...

Q: When I try to save a file, Amadeus II crashes.

A: There is an incompatibility with certain installations of QuickTime 5. Enable the “Don’t use Quick-
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Time” option in the preferences. (Do this only if you experience the abovementioned crashes.)

8 Registering

Some functions are disabled after 15 days in the demo version; everything else can be accessed. If a function
seems to be disabled, it means either that it is not accessible in the current state of the program or that it is
not implemented yet. Before these 15 days, everything works exactly as if the program was registered.

Registering Amadeus II enables those disabled functions again. Moreover, you will be put in a mailing list
that keeps you informed about every new version. If you want to be removed from that mailing list, just tell
me at martin@hairersoft.com.

The registration fee for Amadeus II is 25$ US, to be paid to Kagi, not to me directly. (It costs me about 7$ to
cash a cheque.) Kagi will then provide you with a serial code, which has to be entered in the Registration...
dialog of the Apple menu. If, for any reason, Kagi processes your payment but does not provide you with a
serial code, please send me an email and I will provide you with one. The easiest way to register is to

register online at http://order.kagi.com/?L85.

The online page also allows to print the registration form needed to pay cash or by cheque. For information
about registering without internet access, see the “Read Me (Register)” file in the “Register” folder.
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